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When using Personal Daq modules to acquire data, computer energy save modes can cause false data 
readings.   Prior to using Personal Daq modules, ensure your computer’s energy save mode is disabled.  
If needed, consult your computer’s user manual to disable energy save (power suspension) modes. 

 

Overview 
Personal DaqViewXL is a software component add-in that installs into Microsoft Excel and provides 
complete setup and data acquisition within Excel under Windows 98/Me/2000 and /XP.  Acquired data is 
immediately placed in an active spreadsheet, analyzed and graphically displayed.  Personal DaqViewXL 
provides: 

• data acquisition and analysis 
• report printouts of data text and graphics 
• strip-chart graphics for real-time data display 
• conversion of data to engineering units 
• data editing 
• formula creation  

After Personal DaqViewXL has been installed, you can configure your data acquisition system easily by 
accessing the desired window from the program’s toolbar, i.e., with use of the Configure Devices, 
Configure Channels, or Configure Acquisition buttons.  Each column in the channel-configuration 
window corresponds to a specific parameter in the data acquisition system.  Note that the channels can be 
configured individually. 

In regard to creating data reports, you can embed Excel “spreadsheet objects” directly into a word 
processing program, add text, and print the end result.  To revise the report’s text, just edit the document as 
needed.  To update the spreadsheet, double-click on the embedded “spreadsheet object” to access 
Personal DaqViewXL; then create and embed a new “spreadsheet object.”  

Personal DaqView XL supports all models of the Personal Daq family, including expansion modules and 
provides the engineering unit output required for each configured channel on an individual basis.  For 
example, data for a voltage channel can be returned in volts, while data from a thermocouple is being 
returned in degrees.  

You can use Personal DaqViewXL’s “scale and offset” feature to automatically convert channel data to 
custom units and then have the scale and offset applied to the data prior to its appearing in the spreadsheet.  
The scale and offset feature is especially handy for transducers such as strain gages because it converts the 
return voltage value to units such as pounds or units of pressure. 
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System Requirements 
For successful operation of Personal DaqViewXL with your Personal Daq system, your computer should 
conform to the following as a minimum: 

• PC system with Pentium processor 
• USB port 
• Microsoft Excel, version 8 
• Microsoft Windows 98SE (Second Edition), Windows/Me/2000 or /XP 
• 16 Mbytes of RAM (32 Mbytes recommended) 
• Energy Save modes disabled (see the Caution on page 1) 

 

Installation 
You will need to use an Authorization Code the first time you launch Personal DaqViewXL.  The code is 
provided when the application is purchased. 

Note 1:  The following steps assume that Personal DaqView has already been installed. 

Note 2:  If you are replacing Personal DaqViewXL with a newer version, you should remove the older 
version prior to installing the new application. 

To install the Personal DaqViewXL application: 

1. Run Personal DaqView. 
2. Select Authorization from the File pull-down menu.  An Authorization dialog box will appear. 
3. Type in the code, as it appears on your Authorization Sheet. 
4. Click the <Apply Code> button. 

First Time Use 
Personal DaqViewXL is an Excel “add-in” that must be loaded into the Excel environment before it can be 
used.  Perform the following steps to load Personal DaqViewXL into Excel: 

1. Start Excel (refer to Microsoft documentation as needed). 

2. Select the “Tools” menu and click on “Add-Ins.”  This will open the “Add-Ins” dialog box, as 
shown below. 

 
Excel’s “Add-Ins” Dialog Box

2    491-0905, rev 3.0 918596 Personal DaqViewXL User’s Guide 



 

3. Click the “Browse” button and locate the file pDaqView.xla.  This file is located in the install 
directory specified by the setup program.  Click OK. 

 
Browse Option Dialog Box 

4. Select Personal DaqViewXL from the “Add-Ins Available” list.  Make sure there is a check next to 
Personal DaqViewXL, and then click OK. 

 
Add-Ins Dialog Box with Personal DaqViewXL Selected 

5. Excel loads the “add-in,” creating a Personal DaqViewXL item in the Tools pull-down menu and a 
toolbar. 

 

Personal DaqViewXL Menu Options 

 
 
 
(1) Configure Devices 
(2) Configure Channels 
(3) Configure Acquisition 
(4) Go! 
(5) Manual Trigger 
(6) Chart Display 
(7) Bar Graph Meters 
(8) Analog Meters 
(9) Digital Meters 
(10) Use Data Destination 
(11) Set Data Destination Cell 
(12) Use Data Header 

 

Personal DaqViewXL Toolbar Options 
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After Personal DaqViewXL is installed in this manner, it will automatically load whenever you run Excel. 

6. If you want to start Personal DaqView when Personal DaqViewXL is used for the first time: 
a)  Click the Personal DaqViewXL selection (located in Excel’s Tools pull-down menu). 
b)  Choose “Options…” (the Options Dialog Box appears). 
c)  Select “Start the first time I use Personal DaqViewXL.” 
d)  Click “OK.” 

 
Personal DaqViewXL Start-up Options Dialog Box 

7. If you want to start Personal DaqView as soon as Excel is opened: 
a)  Click the Personal DaqViewXL selection (located in Excel’s Tools pull-down menu). 
b)  Choose “Options…” (the Options Dialog Box appears). 
c)  Select “Start as soon as I open Excel.” 
d)  Click “OK.” 

Note: After you have launched Excel and Personal DaqViewXL has been activated, the following dialog 
box appears if Personal DaqView is not running.  If this is the case, click “Yes” to start Personal 
DaqViewXL. 

 
Personal DaqView Startup Confirmation 

The following figure shows a partial screen capture of a Microsoft Excel spreadsheet.  In the figure, the 
Personal DaqViewXL item has been selected from the Tools pull-down menu.  Personal DaqViewXL’s 
toolbar can also be seen in the figure. 

 
Microsoft Excel Spreadsheet showing Personal DaqViewXL Menu Options

4    491-0905, rev 3.0 918596 Personal DaqViewXL User’s Guide 



 

Configuration Reference 
The following information is intended to serve as a quick reference regarding channel configuration.  You 
should refer to the user’s manual for more detailed information regarding Personal DaqView, as needed.   

Toolbar Buttons 
Note:  The functions that can be obtained through the toolbar can also be obtained through the pull-down 

menus. 

 

Personal DaqViewXL Toolbar 
Button Function 

1 Configure Devices Opens the Select Active Devices window. 

2 Configure Channels Opens the Channel Configuration Spreadsheet.  If the window is already open, 
pressing this button gives the window focus. 

3 Configure Acquisition Opens the Configure Acquisition Dialog.  Various acquisition parameters can be set 
from this dialog. 

4 Go! Starts an acquisition and inserts the data into the current spreadsheet destination 
cell.  Pressing the button again stops the acquisition. 

5 Manual Trigger Manually triggers the acquisition when applicable. 

6 Chart Display Opens the Chart Display, where data is displayed in graphical in a chart format.  If 
Chart Display is already open, pressing this button gives the window focus. 

7 Bar Graph Meters Display Opens the Bar Graph Meters, where data is displayed in a bar graph format.  If Bar 
Graph Meters is already open, pressing this button gives the window focus. 

8 Analog Meters Display Opens the Analog Meters Display, where data is displayed in an analog meter 
format.  If Analog Meters Display is already open, pressing this button gives the 
window focus. 

9 Digital Meters Display Opens the Digital Meters Display, where data is displayed in a digital meter format.  
If Digital Meters is already open, pressing this button gives the window focus. 

10 Use Data Destination Turns the Use Data Destination feature on or off. 

11 Set Data Destination Cell Sets the data destination cell to the “active” cell in the current workbook. 

12 Use Data Header Turns the Use Data Header feature on or off. 

 

Tools Pull-Down Menu 
When the Personal DaqViewXL add-in is loaded, a Personal DaqViewXL menu is added to Excel’s 
Tools pull-down menu.  You can use the menu items to perform all actions that are available from 
Personal DaqViewXL’s toolbar.  Note that some of the pull-down items have no toolbar equivalent.  

Menu Item Function 
1 New Configuration Provides a means of creating a new configuration from default settings. 

2 Open Configuration… Provides a means of opening an existing configuration file.  This feature may be 
used to open configuration files created by the Personal DaqView application. 

3 Save Configuration Saves the configuration file under its existing filename.  Note that you can open 
Personal DaqViewXL files from the Personal DaqView application.  

4 Save Configuration As… Copies the current file for saving under a different filename. 

5 Configure Devices… Opens the Select Active Devices window. 

6 Configure Channels Opens the Channel Configuration Spreadsheet.  If the window is already open, 
pressing this button gives the window focus. 

7 Configure Acquisition… Opens the Configure Acquisition Dialog.  Various acquisition parameters can be set 
from this dialog. 

8 Go! Starts an acquisition and inserts the data into the current spreadsheet destination 
cell.  Selecting the item again stops the acquisition. 
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9 Manual Trigger Manually triggers the acquisition when applicable. 

10 Update Digital Outputs Updates the digital output channels.  This item is only enabled when the digital 
output channels are not updated and the acquisition state is idle. 

11 Save Power-up Settings Saves the current power-up settings for all devices in the configuration.  The 
power-up settings take effect when the device is first plugged into an active USB 
port. 

12 Chart Display Opens the Chart Display, where data is displayed in graphical in a chart format.  If 
Chart Display is already open, selecting this item gives the window focus. 

13 Bar Graph Meters Display Opens the Bar Graph Meters, where data is displayed in a bar graph format.  If Bar 
Graph Meters is already open, selecting this item gives the window focus. 

14 Analog Meters Display Opens the Analog Meters Display, where data is displayed in an analog meter 
format.  If Analog Meters Display is already open, selecting this item gives the 
window focus. 

15 Digital Meters Display Opens the Digital Meters Display, where data is displayed in a digital meter format.  
If Digital Meters is already open, selecting this item gives the window focus. 

16 Use Data Destination Turns the Use Data Destination feature on or off. 

17 Set Data Destination Cell Sets the data destination cell to the “active” cell in the current workbook. 

18 Use Data Header Turns the Use Data Header feature on or off. 

19 Options… Opens Personal DaqViewXL’s Options Dialog. 

20 Preferences… Opens Personal DaqViewXL’s Preferences Dialog.  From this dialog box you can 
use the General and Measurement Units dialog boxes as described below. 

General − Allows you to select “untitled” or “pDaq” 
configurations for the default filename used by 
Personal Daq.  Note that Personal DaqView automatically 
loads the last saved configuration file.  The lower portion of 
the General screen pertains to configuration file settings. 

 

 

Measurement Units − Allows you to set the desired default 
units for the Channel Configuration Window’s spreadsheet.  
Note that scale and offset automatically reset to a pre-
designated default according to the unit selected. 

Changing the measurement unit defaults does not 
immediately affect the Channel Configuration Window’s 
spreadsheet columns.  For example:  If you set your voltage 
default to µV, but the channels are set with V units, they will 
retain the V units.  However, changing these channels to 
temperature, then back to voltage would result in the default 
units (µV) and the associated scale & offset.  The new 
default units are also applied to all channels when a new 
configuration file is created. 

 Preferences Screen Captures (Condensed Images) 
 

21 About… Provides version information for the active Personal DaqViewXL add-in and the 
Personal DaqView application. 

22 Help… Launches the Personal DaqViewXL section of the Personal DaqView help file. 
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Channel Configuration Window 
You can bring up the Channel Configuration Window by using the Configure Channel Settings button (9) 
on the Main Control Window toolbar, or by selecting Configure Channels from the Personal DaqViewXL 
pull-down menu. 

The Channel Configuration Window contains a Control pull-down menu and a 2-button toolbar.  The 
window displays any one of three tabbed spreadsheets for selecting the type of channel to be configured.  
The tabs are labeled Analog Input, Frequency/Pulse Input, and Digital Input/Output. 

 
Channel Configuration Window, Selected for Analog Input Spreadsheet 

Toolbar 
The Channel Configuration Window consists of two buttons (items 16 and 17) as identified by the previous 
figure and the following table. 

 
Button Function 

16 Enable Readings 
Column 

Activates the Channel Configuration Window’s reading column.  Does not affect the 
recording of data to the destination spreadsheet. 

17 Disable Readings 
Column 

Stops the Channel Configuration Window’s reading column.  Does not affect the 
recording of data to the destination spreadsheet. 

 

Channel Configuration Window Pull-down Menu 
The channel configuration window contains one pull-down menu labeled, Control.  This menu provides a 
means of enabling and disabling the readings column, as do toolbar items (16 and 17).  
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Auto-Load Function 
Excel’s “Add-Ins” dialog box has a check-box for enabling ( ) or disabling an automatic loading of 
Personal DaqViewXL each time you run Excel.  To enable or disable the auto-load feature, refer to the 
following two paragraphs as needed. 

Disabling Auto-Load 
If you want to avoid an automatic loading of Personal DaqViewXL each time you run Excel, perform the 
following steps: 

1. Start Excel. 
2. Select the “Tools” menu and click on “Add-Ins.”  The “Add-Ins” dialog box opens. 
3. Locate the Personal DaqViewXL line in the “Add-Ins Available” list box and click on it.  This should 

remove the checkmark next to the item. 
4. Click “OK.” 

Personal DaqViewXL will no longer auto-load with Excel.  See the following paragraph for simple steps on 
enabling the Personal DaqViewXL auto-load feature. 

Enabling Auto-Load 
If you want Personal DaqViewXL to automatically load each time you run Excel, perform the following 
steps: 

1. Start Excel. 
2. Select the “Tools” menu and click on “Add-Ins.”  The “Add-Ins” dialog box opens. 
3. Locate the Personal DaqViewXL line in the “Add-Ins Available” list box and click on it.  This should 

insert a checkmark ( ) next to the item. 
4. Click “OK.” 

Personal DaqViewXL will now auto-load with Excel.  See the previous paragraph for simple steps on 
disabling the Personal DaqViewXL auto-load feature. 

 

 

Performance of Personal DaqViewXL 
Personal DaqViewXL performs in much the same manner as the standard Personal DaqView, with the 
noted difference that the XL version can use Excel macros.  The following sections provide basic 
information for using Personal DaqViewXL to organize and analyze data.  An understanding of these 
basics will let you explore each of Personal DaqViewXL’s many features. 

 

Note:  The Hints and Tips section contains suggestions for improving your productivity with 
Personal DaqViewXL.  If you are not proficient with Excel, please refer to your Excel 
documentation as needed.  The more you know about Excel, the better your understanding 
and use of Personal DaqViewXL will be. 
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Personal DaqViewXL Spreadsheet with Toolbar and Displays 

 

 

 
Personal DaqViewXL Toolbar 

 
(1) Configure Devices 
(2) Configure Channels 
(3) Configure Acquisition 
(4) Go! 
(5) Manual Trigger 
(6) Chart Display 
(7) Bar Graph Meters 
(8) Analog Meters 
(9) Digital Meters 
(10) Use Data Destination 
(11) Set Data Destination Cell 
(12) Use Data Header 
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Configuring an Acquisition 
To set up your configuration, once Personal DaqViewXL has been installed; complete the following steps: 

1. Enter Excel. 

 
Personal DaqView Channel Configuration Screen within Excel 

 

 

2. Configure acquisition settings using the Configure Devices, Configure Channels, and 
Configure Acquisition toolbar buttons or tool pull-down menu selections. 

 

 

These steps launch Personal DaqView’s configuration screens.  Note that the Personal DaqView 
configuration information, found in the Personal Daq User’s Manual, still applies to Personal DaqViewXL.  
Also see the section in this user’s guide, Configuration Reference, beginning on page 5. 

10    491-0905, rev 3.0 918596 Personal DaqViewXL User’s Guide 



Real-Time Charting 
Personal DaqViewXL provides a real-time strip-chart window (as in Personal DaqView) for graphical 
presentation of data.  You can select up to 16 channels of data, with one channel assigned to each graph.  
The strip-chart representation is continuous while data is being collected.  All 16 charts are synchronized 
and have an adjustable scrolling speed that can be set independent of the sampling rate.  Selecting the 
Charts icon in the Personal DaqViewXL toolbar will activate the following window.  The chart selection 
must be made prior to initiating an acquisition (selecting the Go! icon). 

 

 
Personal DaqViewXL Real-Time Charting 
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Data Header 
Personal DaqViewXL’s optional data header supplies the global acquisition parameters and the 
configuration of each channel and places this information directly in the spreadsheet along with acquired 
data.  Examples of frequently used header information include: channel gain, thermocouple type, units, and 
channel label.  To activate Data Headers select the Use Data Headers icon in the Personal DaqViewXL 
toolbar. 

 

 
Personal DaqViewXL Data Header 
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Hints and Tips 
• If Personal DaqView is running as a stand-alone application when you start to use Personal DaqViewXL, 

Personal DaqView will switch to a special “server mode.”  This “server mode” supports transactions with 
“client” applications such as Excel.  Note that you must close Excel prior to using Personal DaqView again 
as a stand-alone application. 

• When you acquire data into a worksheet, some of the data may be displayed as a string of pound characters 
(######).  Excel will use these characters when a column is not wide enough to display all the digits of a 
given number.  Sufficient widening of the column will eliminate the symbols.  You can widen columns 
using the “Format, Column, Auto Fit Selection” menu command.  Clicking on this menu-item 
automatically adjusts column widths to accommodate the data. 

• Personal DaqViewXL does not have to be used as an Excel “Add-In;” it can also be loaded as a workbook.  
To do so, open pDaqView.xla using the File Open dialog box.  The Personal DaqViewXL toolbar and 
menu items will be added to Excel. 

• When loading the Personal DaqViewXL add-in manually, Excel does not automatically create a blank 
workbook.  To create a workbook, access the File, New menu item (after Excel loads with Personal 
DaqViewXL). 

Note: When you load Personal DaqViewXL as a workbook, it will not automatically load the next time 
you run Excel.  However, it will appear in the recently used list at the bottom of the File menu, 
making it easy to load the next time you run Excel. 

• You can arm an acquisition from an Excel macro as shown in the following VBA code example: 

 
Sub GoMacro() 
 Dim cbpMenu As CommandBarPopup 
 Dim cbButton As CommandBarButton 
 
 'Get the Personal DaqViewXL menu object. 
 Set cbpMenu = CommandBars("Tools").Controls("Personal DaqViewXL") 
 'Get the "Go!" command button object. 
 Set cbButton = cbpMenu.Controls(8) 
 'Execute the button's command if the button is enabled. 
 If cbButton.Enabled Then cbButton.Execute 
End Sub 

 
This is equivalent to clicking "Go!" on the Personal DaqViewXL menu or toolbar.  Any of the other 
commands on the Personal DaqViewXL menu may be executed in a similar manner. 

 

• If Personal DaqView cannot connect to your hardware on start-up, it will automatically switch to the 
Simulated Instrument mode when loaded from Personal DaqViewXL. 
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